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Татьяна Юрьевна Соколова

AutoCAD 2009 для студента. Самоучитель

Введение

Постоянно растущий уровень компьютерных технологий, динамичное развитие программных и аппаратных средств влекут за собой бурный переход от традиционных методов ведения проектно-конструкторских работ к использованию новых автоматизированных систем разработки и выполнения конструкторской документации.
На сегодняшний день производство продукции мирового класса возможно только на соответствующем оборудовании и с использованием современных средств автоматизации. Ни одно предприятие, ведущее разработки сложных технических объектов, теперь не обходится без использования компьютеров и мощного программного обеспечения, позволяющего гармонично сочетать форму и содержание проекта, оптимизировать процесс разработки и выполнения конструкторской документации при многократном использовании имеющихся данных.
Базовые графические системы обогащают, но не усложняют возможности творческого поиска конструкторов, поскольку обладают высокотехнологичными и удобными, простыми в обращении инструментами, при помощи которых в одном проекте реализуются замыслы целой команды проектировщиков и требования заказчиков. На базе универсальных графических систем разрабатываются автоматизированные рабочие места конструкторов, технологов, архитекторов, схемотехников и многих других разработчиков.
Новейшие компьютерные технологии предоставляют современные аппаратные, программные и информационные средства, реализующие автоматизацию инженерно-графических работ. При этом предполагается обеспечение ввода, вывода, создания, хранения и обработки моделей геометрических объектов и их изображений с помощью компьютера, а также наличие средств моделирования геометрических объектов, их обработки и др.
В последнее время все больше утверждается оригинальный подход к автоматизации конструкторской деятельности, в основе которого – создание трехмерных геометрических представлений графических моделей изделий. Современный уровень развития компьютерных технологий позволяет создавать пространственные модели объектов с практически неограниченными возможностями, обеспечивая большую достоверность решения геометрических и других задач для пространственной модели, что позволяет перейти на качественно новый уровень разработки.
В настоящее время существует множество графических редакторов и программ геометрического моделирования. Компания Autodesk – один из ведущих производителей систем автоматизированного проектирования и программного обеспечения для конструкторов, дизайнеров, архитекторов. Это крупнейший в мире поставщик программного обеспечения и услуг для промышленного и гражданского строительства, машиностроения, геоинформатики, цифровых средств передачи информации и беспроводной связи, обслуживающий 7 000 000 пользователей.
Система AutoCAD, разработанная этой компанией, является лидирующей в мире платформой программного обеспечения систем автоматизированного проектирования (САПР), предназначенной для профессионалов, которым требуется воплощать свои творческие замыслы в реальные динамические проекты.
AutoCAD – программа с богатой и во многом уникальной историей. Впервые она увидела свет в 1982 году под именем MicroCAD. Первая версия AutoCAD ознаменовала начало настоящей революции в автоматизированном проектировании. Сегодня AutoCAD переводится на 18 языков, ее используют в своей работе миллионы проектировщиков во всем мире на процессорах в тысячи раз мощнее тех, которые были установлены на первых персональных компьютерах.
AutoCAD является постоянно развивающейся базовой средой проектирования, каждая новая версия которой наследует все лучшее от предыдущих и направлена на решение следующих основных задач: повышение производительности и эффективности работы пользователей; обеспечение многократного использования имеющихся наработок; беспрепятственное сотрудничество пользователей при проектировании; адаптация AutoCAD к индивидуальным потребностям разработчиков объектно-ориентированных задач.
Залог успеха Autodesk – мировое признание AutoCAD в качестве стандарта дефакто для разработки продуктов и комплектующих, а также документации. Используя свою стратегию, направленную на помощь заказчикам в создании, организации и распространении цифровых конструкторских данных и в решении серьезных бизнес-проблем, Autodesk предлагает наиболее полный комплект интегрированных программных инструментов двумерного и трехмерного конструирования, что позволяет создавать более качественные продукты, ускорять вывод изделий на рынок и добиваться максимальной наглядности проектов и максимально эффективного сотрудничества.
Благодаря выпуску AutoCAD 2009 компания Autodesk предлагает архитекторам, дизайнерам, инженерам и проектировщикам новый инструмент для еще более полного воплощения их идей в реальность.
Тренинг-система

Для удобства читателей и лучшего усвоения ими приемов работы в программе в данной книге предлагается авторская тренинг-система. Все упоминания о ней выделяются так же, как данная врезка. Архив с приведенными упражнениями уникальной авторской электронной тренинг-системы вы можете скачать с сайта издательства «Питер» по адресу http://www.piter.com/download/978538800372.



От издательства

Ваши замечания, предложения и вопросы отправляйте по адресу электронной почты dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о наших книгах.

Глава 1

AutoCAD 2009. Общие сведения

Требования к системе

AutoCAD может работать как в автономном режиме, так и в локальной сети. Для эффективной работы AutoCAD 2009 под управлением операционной системы Windows необходимы следующие программные и аппаратные средства:

• процессор Intel® Pentium® IV;

• операционные системы: Microsoft® Windows® XP Professional или Home Edition (пакет обновлений SP1 или SP2), Windows XP Tablet PC Edition (SP2) или Windows 2000 (SP3 или SP4). Рекомендуется устанавливать и эксплуатировать AutoCAD либо в операционной системе, локализованной на одном языке с программой, либо в англоязычной версии одной из перечисленных систем;

• Microsoft® Internet Explorer 6.0 (пакет обновлений SP1 или более поздний);

• 512 Мбайт оперативной памяти;

• монитор VGA с разрешением не менее 1024 × 768 и поддержкой режима true color;

• 750 Мбайт свободного места на жестком диске для установки;

• привод компакт-дисков: любой (только для установки программы).

Требования к системе при использовании AutoCAD 2009 для концептуального проектирования:

• процессор Intel® с тактовой частотой 3,0 ГГц и выше;

• Windows XP Professional (пакет обновлений SP2);

• не менее 2 Гбайт оперативной памяти;

• 2 Гбайт свободного места на жестком диске, не считая места, необходимого для установки программы;

• Монитор с минимальным разрешением 1280 × 1024 и поддержкой режима true color;

• графический адаптер класса рабочих станций, снабженный не менее 128 Мбайт памяти и поддерживающий технологию OpenGL.

Запуск системы AutoCAD

Запуск AutoCAD осуществляется следующими способами:

• на Панели задач выберите из меню Start → Programs → Autodesk → AutoCAD 2009;

• на Рабочем столе Windows дважды щелкните на пиктограмме AutoCAD 2009.

При запуске AutoCAD предлагает создать новый неименованный рисунок. Можно либо начать создавать в нем объекты, либо загрузить с диска один из уже имеющихся файлов.

При открытии ранее подготовленного имеющегося рисунка всем системным переменным присваиваются значения, которые они имели в ходе последнего сеанса работы с ним. Это происходит благодаря тому, что переменные сохраняются в файле вместе с рисунком.

Если же вы начинаете работу с нуля, следует предварительно задать ряд установок. Обычно это делается автоматически с помощью Мастера подготовки Wizard Description. AutoCAD позволяет менять установки и в ходе сеанса, если возникает такая необходимость.

Начало работы

После запуска AutoCAD выводится диалоговое окно начала работы Startup (рис. 1.1).
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Рис. 1.1. Диалоговое окно начала работы





В диалоговом окне Startup пользователю предлагаются четыре кнопки, в зависимости от выбора которых меняется содержимое диалогового окна:
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Open a Drawing – для открытия ранее созданного чертежа. Позволяет выбрать из списка один из рисунков, открывавшихся последними, и загрузить его в AutoCAD. Чтобы загрузить файл, отсутствующий в списке, следует нажать кнопку обзора Browse…;
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Start from Scratch – для создания чертежа, где устанавливаются только единицы измерения в области Default Settings: британские (футы и дюймы) или метрические (миллиметры):

• Imperial (feet and inches) – создание нового рисунка, использующего британскую систему единиц измерения, по шаблону acad.dwt. При этом область рисования, называемая еще лимитами рисунка, устанавливается равной 12 × 9 дюймов;

• Metric – создание нового рисунка, использующего метрическую систему единиц измерения, по шаблону acadiso.dwt. При этом область рисования устанавливается равной 429 × 297 мм;
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Use a Template – для создания чертежа по шаблону – документу, установки которого используются как основа для нового рисунка. В области Select a Template: выбирается шаблон, содержащий необходимые установки черчения. В списке перечисляются имена файлов шаблонов с расширением DWT, которые найдены по стандартному пути, заданному в диалоговом окне настроек Options. В шаблонах определяются различные параметры рисунка, в том числе наборы специально созданных слоев, типов линий и видов;
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Use a Wizard – вызов Мастера для установки параметров нового чертежа. В области Select a Wizard: предлагается два режима автоматической настройки рабочей среды AutoCAD – детальная подготовка Advanced Setup и быстрая подготовка Quick Setup.

• Диалоговое окно детальной подготовки Advanced Setup позволяет выполнить полную установку параметров рабочей среды AutoCAD: назначить единицы измерения длины Units и угла Angle, задать начало отсчета угла Angle Measure и направление его измерения Angle Direction, определить границы области рисунка Area.

• Диалоговое окно быстрой подготовки Quick Setup позволяет выполнить быструю установку параметров рабочей среды AutoCAD: выбрать единицы измерения длины Units и определить границы области черчения Area.

Диалоговое окно начала работы Startup вызывается при каждой загрузке сеанса AutoCAD только один раз. В дальнейшем для создания рисунков в уже запущенном сеансе AutoCAD открывается диалоговое окно создания нового рисунка Create New Drawing.

Подробнее о шаблоне

Установленный набор параметров сеанса можно сделать доступным и для рисунков, создаваемых впоследствии. Для этого следует сохранить документ как шаблон. Шаблон обычно представляет собой рисунок, не содержащий никаких графических объектов и используемый только для хранения стандартных значений системных переменных.

Шаблоны (файлы с расширением DWT) – весьма удобное средство создания набора рисунков с однотипными настройками. Можно использовать как шаблоны, поставляемые с AutoCAD, так и созданные пользователем. Любой имеющийся рисунок можно сохранить в качестве шаблона. В этом случае значения всех параметров настройки сохраняемого документа будут наследоваться всеми создаваемыми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше всего подготовить набор стандартных шаблонов, где представлены чаще всего используемые установки и базовые элементы:

• тип и точность представления единиц;

• лимиты рисунка;

• настройки режимов шага SNAP, сетки GRID и ортогонального режима ORTHO;

• организация слоев;

• основные надписи, рамки и логотипы;

• размерные и текстовые стили;

• типы и веса (толщины) линий.

Никакие изменения, вносимые в рисунок, созданный на основе шаблона, на сам шаблон не распространяются.


Вызов справочной системы
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В любой момент работы с AutoCAD вы можете получить доступ к электронной документации по программе. Для этого необходимо выбрать в падающем меню пункт Help. Альтернативный вариант – нажать клавишу F1 на функциональной клавиатуре, ввести символ ? в командной строке или щелкнуть на пиктограмме со значком вопроса на стандартной панели инструментов.

Открытие рисунков

Программа AutoCAD по умолчанию записывает внутреннее представление рисунка в файл с расширением DWG. Кроме рисунка файл содержит ряд параметров, определяющих значения переключателей режимов шага SNAP, сетки GRID, ортогонального режима ORTHO; принятые единицы измерения и точность представления; границы рисунка; организацию слоев; форматы и логотипы; размерные и текстовые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирования Multiple Design Environment (MDE), которая допускает одновременное открытие нескольких чертежей. В одном сеансе работы можно открывать неограниченное количество рисунков, не жертвуя при этом производительностью. Среда MDE позволяет перетаскивать объекты, копировать их свойства, такие как цвет, слой, тип линии, из одного рисунка в другой. Она обеспечивает параллельную работу с несколькими рисунками, не прерывая выполнения текущей команды и не нарушая последовательности действий. Это существенно упрощает выполнение многих операций и повышает эффективность работы.
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Открыть существующий рисунок можно с помощью команды OPEN, которая вызывается из падающего меню File → Open… или щелчком на пиктограмме Open… (CTRL+O) на стандартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD появляется диалоговое окно выбора файла Select File (рис. 1.2). Здесь можно выбрать имя файла из списка или ввести это название в поле File name:.

[image: ]
Рис. 1.2. Диалоговое окно выбора файла





При выделении в списке одного из файлов в области Preview появляется соответствующий образец рисунка. Нажатие кнопки Views выводит список, изменяя параметры которого пользователь может выбрать форму представления файлов, предлагаемых для открытия: список, таблицу, образцы.

Режим открытия файлов – Open (открыть), Open Read-Only (открыть для чтения), Partial Open (открыть частично), Partial Open Read-Only (открыть для чтения частично) – устанавливается в списке при нажатии стрелки справа от кнопки Open. Частичное открытие позволяет загружать только те объекты рисунка, которые принадлежат определенным слоям или видовым экранам. Это оказывается полезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следует выбрать необходимые файлы в диалоговом окне Select File, используя клавишу Shift или Ctrl.

Кроме того, рисунки можно открывать путем перетаскивания из Проводника Windows. Для этого один или несколько выделенных в дереве Проводника файлов следует перетащить с помощью мыши в любую часть окна AutoCAD, за исключением области рисунка, например, на командную строку или в ту часть панелей инструментов, которая не занята кнопками. Если же перетащить один файл в область рисования уже открытого рисунка, то произойдет вставка содержимого перетаскиваемого документа в текущий рисунок в качестве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени соответствующего файла в Проводнике Windows, что приведет к автоматическому запуску AutoCAD. Если же в системе уже ведется сеанс работы в AutoCAD, то рисунок откроется в нем.

В AutoCAD имеется специальное средство просмотра небольших фрагментов рисунков, открытия файлов рисунков и их поиска. Его можно использовать для поиска файлов в структуре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска файлов Find, показанного на рис. 1.3, необходимо в диалоговом окне Select File последовательно щелкнуть на кнопках Tools → Find….
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Рис. 1.3. Диалоговое окно просмотра и поиска файлов




На вкладке Name & Location диалогового окна Find указываются имя, расширение и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам их создания, пользуясь вкладкой Date Modified диалогового окна Find (рис. 1.4). Здесь организуется поиск файлов, созданных или измененных в период между двумя указанными датами либо за определенное количество последних дней или месяцев. Имена найденных документов отображаются в нижней части диалогового окна.
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Рис. 1.4. Вкладка поиска файлов





Рисунки, созданные в AutoCAD любой предшествующей версии, открываются как любой документ версии 2009 и автоматически преобразуются в новый формат.

Создание рисунков

При создании рисунка могут использоваться различные стандарты. Иногда они диктуются государственными и отраслевыми стандартами или нормами предприятия, иногда – требованиями заказчика. Ключевой момент как для непосредственных исполнителей, так и для руководителей групп, контролирующих ход выполнения проекта, – грамотная подготовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект. Он может включать в себя множество разделов: планы этажей, схемы сетей водоснабжения, канализации, отопления, вентиляции и т. п. Обычно каждый раздел проекта разрабатывается в отдельном подразделении, поэтому здесь остро встает проблема унификации. Наиболее грамотное ее решение – обеспечение всех исполнителей файлами шаблонов, настроенными на используемую систему единиц и содержащими стандартные рамку, основную надпись, слои и типы линий.

Не менее важно, какие стили используются для текстовых надписей, штрихования и нанесения размеров. Их также следует задавать заранее: это дает гарантию, что каждый проектировщик будет действовать без отклонения от оговоренных стандартов.

Следует ответственно подходить к выбору рабочего масштаба. Только четкое представление о том, как соотносятся единицы рисунка на экране и единицы чертежа, выводимого на плоттер, позволяет правильно выбрать высоту текста для пояснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на последних стадиях проектирования, грамотное планирование на предварительных этапах позволяет избежать многих ошибок и избавить персонал от излишних операций редактирования. При создании проекта работа, как правило, ведется в пространстве модели (здесь объекты представляются в натуральную величину), а для компоновки чертежа выполняется переход в пространство листа, где ко всем графическим объектам, текстам, типам линий и размерам применяется необходимый масштабный коэффициент.

Все начальные установки рисунка могут быть сохранены в шаблоне для последующего использования в других документах. В качестве шаблона могут применяться как рисунки, поставляемые с AutoCAD, так и любые другие, в том числе созданные пользователем. Новый рисунок наследует всю информацию из используемого шаблона. Имеется также возможность запускать AutoCAD без шаблона.
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Создать новый рисунок позволяет команда NEW, вызываемая из падающего меню File → New… или щелчком на пиктограмме QNew на стандартной панели инструментов.

После запуска команды необходимые настройки параметров рабочей среды AutoCAD производятся в диалоговом окне создания нового рисунка Create New Drawing – рис. 1.5.
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Рис. 1.5. Диалоговое окно создания нового рисунка





При создании рисунка по простейшему шаблону используется пиктограмма Start from Scratch. В данном режиме устанавливается британская или метрическая система единиц. Значения многих системных переменных, принятые по умолчанию, зависят от того, какая из двух систем выбрана. Эти переменные управляют текстом, размерами, сеткой, режимами привязки, а также устанавливают действующие по умолчанию тип линий и файл образцов штриховки:

• Imperial (feet and inches) – создается рисунок, использующий британскую систему единиц измерения (футы и дюймы), по шаблону acad.dwt. При этом область рисования, иначе называемая лимитами рисунка, устанавливается равной 12 × 9 дюймов;

• Metric – создается рисунок, где используется метрическая система единиц измерения, по шаблону acadiso.dwt. При этом устанавливается область рисования 429 × 297 мм.

Чтобы создать рисунок с использованием шаблона, необходимо в диалоговом окне Create New Drawing щелкнуть на пиктограмме Use a Template и в списке Select a Template: указать нужный шаблон (рис. 1.6).
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Рис. 1.6. Выбор шаблона рисунка





В AutoCAD имеется так называемый Мастер подготовки Wizard – служебное средство для создания нового рисунка. С помощью Мастера подготовки можно, взяв за основу текущий шаблон, модифицировать некоторые базовые установки. Например, пользователь может автоматически настраивать масштабные коэффициенты для текста в зависимости от общих размеров рисунка. Если рисунки крупные, выбирается большая высота символов, если мелкие – меньшая; таким образом обеспечивается разборчивость текстовых надписей, когда рисунок отображается на экране целиком.

Для вызова Мастера подготовки необходимо в диалоговом окне Create New Drawing щелкнуть на пиктограмме Use a Wizard – откроется окно, показанное на рис. 1.7.
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Рис. 1.7. Создание нового рисунка с помощью Мастера подготовки





Мастер быстрой подготовки QuickSetup (рис. 1.8) позволяет задать для нового рисунка единицы измерения Units и область рисования Area. Поддерживаются следующие типы единиц для рисования и вычерчивания: десятичные – Decimal, инженерные – Engineering, архитектурные – Architectural, дробные – Fractional, научные – Scientific.
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Рис. 1.8. Диалоговое окно Мастера быстрой подготовки





Указывая ширину Width и длину Length области рисования, пользователь тем самым задает граничные пределы рисунка, так называемые лимиты. Именно лимитами определяется размер чертежа, впоследствии выводимого на плоттер. После того как все параметры заданы, Мастер быстрой подготовки запускает сеанс рисования в пространстве модели.

Мастер детальной подготовки Advanced Setup (рис. 1.9) позволяет задать для нового рисунка тип линейных единиц измерения Units и способ измерения углов Angle, указать начало отсчета угла Angle Measure и направление измерения угла Angle Direction, определить границы области рисунка Area. В отличие от Мастера быстрой подготовки, который настраивает только пространство модели, Мастер детальной подготовки воздействует как на пространство модели, так и на пространство листа.
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Рис. 1.9. Диалоговое окно Мастера детальной подготовки





Любая из установок, произведенных в начале рисования, в дальнейшем может быть изменена.


Определение границ рисунка

Команда LIMITS позволяет установить границы текущего рисунка в пространстве модели и в пространстве листа. Она вызывается из падающего меню Format → Drawing Limits. В AutoCAD границы рисунка выполняют две функции: определяют диапазон изменения координат точек и контролируют фрагмент рисунка, покрытый видимой координатной сеткой.

Границы рисунка – это пара двумерных точек в мировой системе координат: координаты левого нижнего и правого верхнего углов, определяющие прямоугольную область. По оси Z границы не устанавливаются.

Запросы команды LIMITS:

Reset Model space limits: – переустановка лимитов пространства модели

Specify lower left corner or [ON/OFF] <current>: – левый нижний угол

Specify upper right corner <current>: – правый верхний угол где:



• ON – включается контроль соблюдения границ. При этом AutoCAD отвергает все попытки ввести точки с координатами, выходящими за границы рисунка;

• OFF – отключается контроль соблюдения границ рисунка;

• <current> – текущее значение.

Если текущее значение границ рисунка вас устраивает, достаточно нажать клавишу Enter.

Лимиты должны полностью охватывать полномасштабную модель. Например, если ее размеры 100 × 200 мм, значения лимитов должны слегка превышать эти цифры.

В пространстве листа лимиты обычно задают равными формату листа бумаги. Следовательно, сетка (если она включена) покрывает при этом весь скомпонованный чертеж, включая графические объекты, размерные элементы, основную надпись и т. п. Например, если формат листа равен 210 × 297 мм, следует установить десятичный формат единиц и определить лимиты указанием точек 0,0 для левого нижнего угла прямоугольника и 210,297 – для правого верхнего угла.

Если в пространстве листа отображаются поля листа или подложен заданный формат, нельзя задать границы рисунка с помощью команды LIMITS. В этом случае лимиты вычисляются и устанавливаются в зависимости от размеров выбранного листа. Включение и отключение отображения полей и разметки листа производится на вкладке Display диалогового окна Options.

В пространстве модели лимиты могут быть заданы при создании нового рисунка с помощью Мастера быстрой подготовки или Мастера детальной подготовки.

Тренинг-система

Выполните упражнение N4 из раздела 1.



[image: ]
Определение параметров сетки

Сеткой называется упорядоченная последовательность точек, покрывающих область рисунка в пределах лимитов. Работа в режиме GRID подобна наложению на рисунок листа бумаги в клетку. Использование сетки помогает выравнивать объекты и оценивать расстояние между ними. Сетку можно включать и отключать в ходе выполнения других команд. На печать она не выводится.

Включение сетки и определение ее частоты осуществляется на вкладке Snap and Grid диалогового окна режимов рисования Drafting Settings (рис. 1.10), которое загружается из падающего меню Tools → Drafting Settings… или при выборе пункта настройки Settings… контекстного меню, вызываемого щелчком правой кнопкой мыши на кнопке Grid Display в строке состояния.
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Рис. 1.10. Диалоговое окно определения параметров сетки и шага привязки





Сетка включается при установке флажка Grid On (F7). В области Grid spacing устанавливается частота горизонтальных и вертикальных делений сетки, то есть шаг сетки по осям X и Y. Это осуществляется в текстовых полях Grid X spacing: и Grid Y spacing: соответственно. В поле Major line every: устанавливается шаг основной линии.

В области Grid behavior определяется режим сетки: Adaptive grid – настройка сетки, Allow subdivision below grid spaсing – разрешение дробления мельче шага сетки, Display grid beyond Limits – показать сетку за лимитами, Follow Dynamic UCS – следовать динамической ПСК.
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При работе с рисунком включать и отключать сетку следует щелчком на кнопке Grid Display в строке состояния или нажатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с новым коэффициентом экранного увеличения может потребоваться изменение частоты сетки.

Тренинг-система

Выполните упражнение N5 из раздела 1.
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Определение шага привязки

В режиме шаговой привязки SNAP курсор может находиться только в определенных точках согласно установленному значению шага и при этом движется не плавно, а скачкообразно между узлами воображаемой сетки, как бы «прилипая» к ее узлам. Активность режима шаговой привязки SNAP можно определить визуально, по скачкообразному движению курсора на экране. Шаговая привязка обычно используется для точного указания точек с помощью мыши. Интервал привязки задается отдельно по осям X и Y. Включение и отключение режима шаговой привязки может производиться в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сетки. Сетку часто делают достаточно редкой, используя ее исключительно для наглядности, а шаг привязки устанавливают меньшим. Допустимо и обратное: установка большего по сравнению с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее параметров осуществляются на вкладке Snap and Grid диалогового окна режимов рисования Drafting Settings, которое загружается из падающего меню Tools → Drafting Settings… или при выборе пункта Settings… из контекстного меню, вызываемого щелчком правой кнопкой мыши на кнопке Snap Mode в строке состояния (см. рис. 1.10).

Шаговая привязка включается при установке флажка Snap On (F9). В области Snap spacing задается шаг привязки по горизонтали и вертикали. Это осуществляется в текстовых полях Snap X spacing: и Snap Y spacing: соответственно.

Параметром Equal X and Y spacing устанавливается равный шаг по осям X и Y. В области Polar spacing задается шаг полярной привязки.

Тип привязки устанавливается в области Snap type. Grid snap – шаговая привязка (Rectangular snap – ортогональная, Isometric snap – изометрическая), PolarSnap – полярная привязка.
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При работе с рисунком включать и отключать шаговую привязку следует щелчком на кнопке Snap Mode в строке состояния или нажатием функциональной клавиши F9.

Тренинг-система

Выполните упражнения N6 из раздела 1 и L4 из раздела 2.
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Сохранение рисунков
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Команда сохранения рисунка QSAVE вызывается из падающего меню File → Save или щелчком на пиктограмме Save CTRL+S на стандартной панели инструментов. Команда QSAVE используется в тех случаях, когда уже существующий рисунок сохраняется без изменения его имени. Если рисунок новый и его имя не определено, то QSAVE действует так же, как команда SAVEAS.

Команды SAVE и SAVEAS предназначены для сохранения рисунка под другим именем. Команда SAVE может вызываться только из командной строки, а SAVEAS – из падающего меню File → Save As…. В обоих случаях имя документа задается в поле File name: диалогового окна Save Drawing As – рис. 1.11.
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Рис. 1.11. Диалоговое окно сохранения рисунка





Предыдущей копии рисунка на диске присваивается расширение BAK вместо DWG. Все предыдущие BAK-файлы с данным именем удаляются. Обновленный рисунок записывается с расширением DWG. Если при указании имени файла оказывается, что рисунок с таким названием уже существует, выдается предупреждение и предоставляется возможность перезаписать файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в раскрывающемся списке Files of type: диалогового окна Save Drawing As необходимо выбрать пункт AutoCAD Drawing Template (*.dwt).

Чтобы обеспечить автоматическое сохранение рисунка через заданные интервалы времени, следует использовать вкладку Open and Save диалогового окна Options. Оно вызывается из падающего меню Tools → Options…. Необходимо установить флажок автосохранения Automatic save в области File Safety Precautions и установить значение интервала в минутах между автосохранениями в поле Minutes between saves.

Получение твердой копии рисунка

Распечатка чертежа – последний этап при работе с рисунком. Перед выводом рисунка на печать необходимо его скомпоновать, то есть определить, какие виды должны быть вычерчены. Работа над рисунком ведется на разных этапах либо в пространстве модели, либо в пространстве листа. Пространство модели предназначено для создания модели – изображения в реальном масштабе. Пространство листа представляет собой аналог листа бумаги, на котором производится создание и размещение видов перед вычерчиванием.

Как в пространстве модели, так и в пространстве листа может быть один или несколько видовых экранов, на которых представлены различные виды модели. Компоновка чертежа, по сути дела, представляет собой процесс создания и размещения таких экранов. По завершении компоновки чертеж выводится на принтер или плоттер.
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Перед выводом рисунка на плоттер можно предварительно просмотреть, как он будет размещаться на листе бумаги. Для этого используется команда предварительного просмотра PREVIEW, вызываемая из падающего меню File → Plot Preview или щелчком на пиктограмме Plot Preview на стандартной панели инструментов. При этом автоматически включается изменение масштаба изображения в режиме реального времени для просмотра мелких деталей чертежа.

Все установки вывода рисунка на плоттер осуществляются в диалоговом окне Plot – Model (рис. 1.12). Это окно загружается командой PLOT, вызываемой из падающего меню File → Plot…, или щелчком на пиктограмме Plot… (CTRL+P) на стандартной панели инструментов.
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Рис. 1.12. Диалоговое окно вывода на печать пространства модели





В диалоговом окне Plot – Model делаются следующие назначения.

• В области Page setup устанавливается набор параметров листа. Кнопкой Add… открывается диалоговое окно добавления набора параметров листа.

• В области Printer/plotter устанавливаются параметры:

· из списка Name: выбирается устройство вывода;

· кнопка Properties… загружает редактор параметров плоттера;

· установкой флажка Plot to file назначается печать в файл.

• В области Paper size определяется формат.

• В области Number of copies устанавливается количество экземпляров.

• В области Plot area устанавливается печатаемая область:

· Display – экран;

· Limits – лимиты;

· Window – область, выбранная рамкой.

• В области Plot offset (origin set to printable area) определяется смещение печатаемой области по осям X и Y, а также центрированность.

• В области Plot scale определяется масштаб печати и веса линий:

· Fit to paper – вписать;

· Scale: – масштаб;

· Scale lineweights – масштабировать веса линий.

• В области Plot style table (pen assignments) определяется таблица стилей печати.

• В области видовых экранов с раскрашиванием Shaded viewport options определяется:

· Shade plot – способ вывода (как на экране, каркас, скрытие линий; 3D-скрытый, 3D-каркас, концептуальный, реалистичный; тонирование, черновое, низкое, среднее, высокое, презентационное);

· Quality – качество (черновое, просмотр, нормальное, презентационное, максимум, пользовательское).

• В области Plot options определяются параметры печати:

· Plot in background – печатать в фоновом режиме;

· Plot object lineweights – учитывать веса линий;

· Plot with plot styles – учитывать стили печати;

· Plot paperspace last – объекты листа последними;

· Hide paperspace objects – скрывать объекты листа;

· Plot stamp on – включить штемпель;

· Save changes to layout – сохранить параметры.

• В области Drawing orientation определяется ориентация чертежа:

· Portrait – книжная;

· Landscape – альбомная;

· Plot upside-down – перевернутая.

• Кнопка Preview… загружает окно предварительного просмотра.

Выход из AutoCAD

Для выхода из AutoCAD используется команда QUIT, которая вызывается из падающего меню File → Exit (CTRL+Q).

Команда позволяет сохранить или проигнорировать сделанные в рисунке изменения и выйти из AutoCAD. Если все выполненные изменения сохранены, при выходе из программы не появится никаких дополнительных сообщений. В противном случае на экран будет выведено диалоговое окно AutoCAD, предлагающее пользователю выбор: сохранить изменения, отказаться от них или продолжить сеанс работы. Если текущему рисунку не было присвоено имя и вы хотите его сохранить, откроется диалоговое окно Save Drawing As.


Глава 2

Пользовательский интерфейс AutoCAD

На рис. 2.1 показан классический рабочий стол AutoCAD для Windows.
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Рис. 2.1. Рабочий стол AutoCAD





В данный рабочий стол включены:

• падающее меню Menu Browser – меню, появляющееся при щелчке кнопкой мыши на кнопке A в верхнем левом углу окна программы (рис. 2.2);

• необязательные панели инструментов:

· стандартная панель Standard и панель стилей Styles – верхняя строка окна программы;

· панель рабочих пространств Workspaces, слоев Layers и свойств Properties – вторая строка;

· панель рисования Draw и редактирования Modify – столбцы слева и справа;

· инструментальная палитра Tool Palettes – в правой части окна программы;

• строка состояния – строка внизу окна программы;

• окно командных строк – выше строки состояния;

• графическое поле, занимающее остальную часть рабочего стола.
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Рис. 2.2. Падающее меню

Падающие меню

Строка падающих меню может быть изменена путем добавления либо удаления тех или иных пунктов. Для этого необходимо выбрать в падающем меню пункты Tools → Customize → Interface…, в появившемся диалоговом окне настройки интерфейса пользователя Customize User Interface на вкладке Customize в области Customizatios in All CUI Files раскрыть пункт Menus (рис. 2.3). Далее установить указатель мыши на один из пунктов меню и, щелкнув правой кнопкой мыши, вызвать контекстное меню, в котором выбрать соответствующий пункт для удаления имеющихся или создания новых падающих меню.
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Рис. 2.3. Диалоговое окно адаптации меню





Строка падающих меню по умолчанию содержит следующие пункты:

• File – команды работы с файлами: создание, открытие, сохранение, публикация в Интернете, печать, экспорт файлов в другие форматы, а также диспетчеры параметров листов, плоттеров, стилей печати и пр.;

• Edit – инструменты для редактирования частей графического поля рабочего стола программы, работы с буфером обмена и пр.;

• View – управление экраном, зумирование, панорамирование, установка трехмерной точки зрения, создание видовых экранов и именованных видов, установка визуальных стилей, тонирование, анимация траектории перемещения, установка необходимых панелей инструментов;

• Insert – команды вставки блоков, внешних объектов, объектов других приложений;

• Format – команды работы со слоями и их инструментами; цветом, типами линий; управление стилями текста, размеров, мультилиний, таблиц; видом маркера точки, установки единиц измерения, границ чертежа;

• Tools – управление рабочими пространствами; палитрами; установка порядка прорисовки объектов и получение сведений о них; работа с блоками и их атрибутами; работа с языком AutoLISP; работа с пользовательской системой координат; настройка стандартов оформления; управление Мастерами (публикации в Интернете, установки плоттеров, создания таблиц стилей печати, цветозависимых стилей печати, компоновки листа, создания подшивки, импорта параметров печати); установка параметров черчения и привязок с помощью диалоговых окон и пр.;

• Draw – команды двумерного и трехмерного рисования;

• Dimension – команды простановки размеров и управления параметрами размерных стилей;

• Modify – команды редактирования элементов чертежа;

• Window – многооконный режим работы с чертежами;

• Help – вывод на экран системы гипертекстовых подсказок.

Панели инструментов

Команды AutoCAD на панелях инструментов представлены в виде пиктограмм. Если задержать указатель мыши на пиктограмме, рядом с ней появляется название соответствующей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен маленький черный треугольник, это значит, что она содержит подменю с набором родственных команд. Для вызова подменю необходимо на некоторое время задержать на пиктограмме указатель мыши, нажав ее левую кнопку.

Панели инструментов могут быть плавающими (float) или закрепленными (dock), с фиксированным местоположением. Допускаются изменения размеров плавающих панелей, а также их перемещение по графическому полю (рис. 2.4). Плавающую панель можно сделать закрепленной, перетащив ее с помощью мыши за пределы графического поля. И наоборот, как только закрепленная панель попадает в область графического поля, она превращается в плавающую.
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Рис. 2.4. Плавающая панель инструментов





При необходимости требуемую панель инструментов можно вывести на рабочий стол, щелкнув левой кнопкой мыши на ее имени в списке контекстного меню. Для получения этого контекстного меню необходимо щелкнуть правой кнопкой мыши, установив ее указатель на любую пиктограмму панелей инструментов (рис. 2.5).
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Рис. 2.5. Список панелей инструментов





Для удаления панели инструментов необходимо сделать ее плавающей, если она закреплена, и щелкнуть на кнопке закрытия, расположенной в правом верхнем углу заголовка панели.




[image: ]
Если набор необходимых панелей и окон упорядочен на рабочем столе, во избежание их случайного перемещения или удаления пользователь может зафиксировать их положение. Для этого следует вызвать контекстное меню щелчком правой кнопки мыши на инструменте, изображающем замочек, в правом углу строки состояния и зафиксировать положение панелей:

• Floating Toolbars/Panels – плавающие панели инструментов;

• Docked Toolbars/Panels – закрепленные панели инструментов;

• Floating Windows – плавающие окна;

• Docked Windows – закрепленные окна;

• All – все инструменты: Locked – заблокированы, Unlocked – разблокированы;

• Help – справка.

Чтобы временно разблокировать панели инструментов, необходимо удерживать нажатой клавишу Ctrl.

Тренинг-система

Выполните упражнения N2 и N3 из раздела 1.
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Стандартная панель инструментов

Стандартная панель Standard показана на рис. 2.6.
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Рис. 2.6. Стандартная панель инструментов





Она содержит следующие инструменты:
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QNew – создание нового файла рисунка;





[image: ]
Open… (Ctrl+О) – загрузка существующего файла;
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Save (Ctrl+S) – сохранение текущего файла;
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Plot… (Ctrl+P) – вывод рисунка на плоттер, принтер или в файл;
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Plot Preview – предварительный просмотр чертежа перед выводом на печать, позволяющий увидеть размещение чертежа на листе бумаги;
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Publish… – публикация листов чертежа в формате файла Design Web Format (DWF), загрузка диалогового окна Publish;
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3DDWF – экспорт трехмерной модели в формате файла Design Web Format (DWF);
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Cut (Ctrl+X) – копирование объектов в буфер обмена с удалением их из рисунка;
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Copy (Ctrl+C) – копирование выбранных элементов чертежа в буфер Windows без удаления их из исходного документа;
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Paste (Ctrl+V) – вставка данных из буфера Windows;
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Match Properties – копирование свойств заданного объекта другому объекту;
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Block Editor – редактирование блоков;
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Undo (Ctrl+Z) – отмена последнего действия;
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Redo (Ctrl+Y) – восстановление только что отмененного действия;
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Pan Realtime – перемещение изображения на текущем видовом экране в режиме реального времени;
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Zoom Realtime – увеличение или уменьшение видимого размера объектов на текущем видовом экране в режиме реального времени;
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подменю Zoom – раскрывающийся набор инструментов, в котором можно задать различные способы увеличения и уменьшения видимого размера объектов на текущем видовом экране;
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Zoom Previous – возврат к показу предыдущего вида;
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Properties (Ctrl+1) – загрузка палитры управления свойствами объектов;
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DesignCenter (Ctrl+2) – диалоговый интерфейс, позволяющий быстро находить, просматривать, вызывать, переносить в текущий рисунок ранее созданные рисунки, управлять вхождениями блоков, внешними ссылками и другими элементами рисунков, такими как слои, листы и текстовые стили;
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Tool Palettes Window (Ctrl+3) – инструментальные палитры в виде отдельных вкладок специального окна, которые служат эффективным средством хранения/вставки блоков и штриховки. Палитры могут содержать инструменты, предоставленные сторонними разработчиками;
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Sheet Set Manager (Ctrl+4) – диспетчер подшивок наборов листов, позволяющий организовать размещение пакетов листов в зависимости от типа чертежей и с возможностью эффективного создания, управления и совместного использования наборов логически связанных рисунков;
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Markup Set Manager (Ctrl+7) – диспетчер наборов пометок, позволяющий организовать работу с рисунками формата DWF;
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QuickCalc (Ctrl+8) – калькулятор;
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Help – вызов справочной системы.

Панель стилей

Панель стилей Styles, показанная на рис. 2.7, предназначена для создания новых текстовых, размерных и табличных стилей.
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Рис. 2.7. Панель стилей





Панель содержит следующие инструменты:
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Text Style… – создание новых и редактирование имеющихся текстовых стилей;
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Dimension Style… – создание новых и редактирование имеющихся размерных стилей;
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Table Style… – создание новых и редактирование имеющихся табличных стилей;
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Multileader Style… – создание новых и редактирование имеющихся стилей линий-выносок.

Панель рабочих пространств

Панель Workspaces, показанная на рис. 2.8, позволяет задавать параметры рабочих пространств.
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Рис. 2.8. Панель рабочих пространств





Рабочие пространства включают только необходимые наборы меню, инструментальные панели и палитры, сгруппированные и упорядоченные соответственно решаемой задаче. Элементы интерфейса, не являющиеся необходимыми для решения текущей задачи, скрываются, максимально освобождая область экрана, доступную для работы.

В AutoCAD определены следующие рабочие пространства:

• 2D Drafting & Annotation – двумерное моделирование (рис. 2.9);

• 3D Modeling – трехмерное моделирование (рис. 2.10);

• AutoCAD Classic – классический AutoCAD (см. рис. 2.1).
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Рис. 2.9. Рабочее пространство для двумерного моделирования





Помимо возможности установить рабочее пространство, в панель Workspaces включены следующие пункты:

• Save Current As… – открытие диалогового окна Save Workspace, позволяющего сохранить текущее рабочее пространство;

• Workspace settings… – открытие диалогового окна Workspace Settings, позволяющего настроить текущие параметры рабочего пространства для последующего использования;
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Рис. 2.10. Рабочее пространство для трехмерного моделирования





• Customize… – открытие диалогового окна Customize User Interface, позволяющего осуществить настройки интерфейса пользователя.

А также панель Workspaces содержит следующие инструменты:

[image: ]
Workspace Settings… – открытие диалогового окна Workspace Settings, позволяющего настроить текущие параметры рабочего пространства для последующего использования;
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My Workspace – возвращение имени текущего рабочего пространства в интерфейс командной строки и установление этого пространства текущим.

Рабочее пространство 3D Modeling включает новый пульт управления, обеспечивающий удобный доступ к новым функциям трехмерного моделирования. В области рисования отображается цвет фона, наземная плоскость или рабочая поверхность и новая прямоугольная сетка, что улучшает трехмерную визуализацию и облегчает создание пространственных моделей. Новый трехмерный курсор обеспечивает указание направления ПСК. Вкладки Model и Lauout заменены кнопками в строке состояния, благодаря чему расширена область рисования. На режим отображения вкладок можно переключиться, щелкнув правой кнопкой мыши на кнопке Model или Lauout.

Тренинг-система

Выполните упражнение N1 из раздела 1.
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Панель слоев

Панель слоев Layers, показанная на рис. 2.11, обеспечивает работу со слоями.
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Рис. 2.11. Панель слоев





В нее входят следующие инструменты:
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Layer Properties Manager – вызов Диспетчера свойств слоев Layer Properties Manager;
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Layer Control – раскрывающийся список управления слоями. Каждая строка содержит пиктограммы управления свойствами слоя или отображения его свойств, а также его имя. Ниже перечисляются эти пиктограммы (слева направо):

• Turn a layer On or Off – включение/отключение слоя;

• Freeze or thaw in ALL viewports – замораживание/размораживание на всех видовых экранах;

• Freeze or thaw in current viewport – замораживание/размораживание на текущем видовом экране;

• Lock or Unlock a layer – блокирование/разблокирование слоя;

• Color of layer – цвет слоя;

• Layer Control – имя слоя.
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Make Object's Layer Current – установка текущего слоя в соответствии со слоем выбранного примитива;
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Layer Previous – возврат к предыдущему состоянию слоев;
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Layer States Manager – загрузка диалогового окна Layer States Manager.

Панель свойств объектов

Панель свойств объектов Properties, показанная на рис. 2.12, предназначена для работы с цветом, типом и весом линий.
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Рис. 2.12. Панель свойств объектов





В нее входят следующие инструменты:
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Color Control – раскрывающийся список установки текущего цвета, а также изменения цвета выбранных объектов;
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Line Type Control – раскрывающийся список установки текущего типа линии, а также изменения типа линии для выбранных объектов;
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Line Weight Control – раскрывающийся список установки текущего веса (толщины) линии, а также изменения толщины линий выбранных объектов;





[image: ]
Plot Styles Control – раскрывающийся список установки стилей печати. Здесь можно изменять внешний вид вычерчиваемого на плоттере рисунка. В стилях печати при необходимости переопределяются цвета, типы и веса (толщины) линий объектов. Кроме этого, имеется возможность указывать используемые при печати стили концов линий, соединений и заполнений, а также различные выходные эффекты – размывание, оттенки серого, присвоения перьев и интенсивность. Манипулируя стилями печати, можно получить на бумаге различные варианты одного и того же рисунка. Допускается применение стилей печати к объектам или слоям.

Строка состояния

Строка состояния (рис. 2.13) расположена в нижней части рабочего стола.
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Рис. 2.13. Строка состояния





Она содержит текущие координаты курсора, а также кнопки включения/выключения режимов черчения:
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Snap Mode – включение и выключение шаговой привязки курсора;
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Grid Display – включение и выключение отображения сетки;
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Ortho Mode – включение и выключение ортогонального режима;
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Polar Tracking – включение и выключение режима полярного отслеживания;
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Object Snap – включение и выключение режимов объектной привязки;
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Object Snap Tracking – включение и выключение режима отслеживания при объектной привязке;
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Allow/Disallow Dynamic UCS – включение и выключение динамической пользовательской системы координат;
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Dynamic Input – включение и выключение динамического ввода;
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Show/Hide Lineweight – включение и выключение режима отображения линий в соответствии с весами (толщинами);
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Quick Properties – включение и выключение свойств объектов;
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Model or Paper space – переключение из пространства модели в пространство листа;
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Quick View Layouts – включение и выключение просмотра листов;
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Quick View Drawings – включение и выключение просмотра рисунков;





[image: ]
Pan – панорамирование рисунка;
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Zoom – зумирование рисунка;
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SteeringWheel – включение инструмента Wheel;
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ShowMotion – включение инструмента Motion.
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Отображение кнопок включения/выключения режимов черчения в строке состояния устанавливается в контекстном меню (рис. 2.14). Для этого необходимо щелкнуть левой или правой кнопкой на инструменте Application Status Bar Menu с изображением стрелки вниз, который находится в правом углу строки состояния.
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Рис. 2.14. Контекстное меню настройки строки состояния





Опция Tray Settings… открывает диалоговое окно Tray Settings (рис. 2.15), позволяющее произвести настройку области уведомлений.

• Display icons from services – показывать значки служб.

• Display notifications from services – показывать уведомления от служб:

· Display time – время отображения;

· Display until closed – до явного закрытия.

[image: ]
Рис. 2.15. Диалоговое окно настройки области уведомлений

Окно командных строк

Окно командных строк обычно расположено над строкой состояния; оно служит для ввода команд и вывода подсказок и сообщений AutoCAD. Размеры окна, а следовательно, количество выводимых строк протокола можно изменять. При наличии в окне команд более одной строки перемещение по строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по ширине окну AutoCAD (рис. 2.16). Если текстовая строка не помещается в окне, ее полное содержимое выводится в рамке вблизи командной строки.

[image: ]
Рис. 2.16. Закрепленное окно командных строк





Изменить высоту окна можно с помощью разделительной полосы, находящейся в его верхней части (если оно закреплено внизу) или в нижней (если оно закреплено вверху). Чтобы изменить размер, следует захватить разделительную полосу с помощью мыши и отбуксировать ее до требуемой высоты.

Окно может быть как закрепленным, так и плавающим. Закрепление отменяется путем выбора рамки окна в любом месте и последующей буксировки за пределы зоны закрепления до тех пор, пока граница окна не примет вид широкой контурной линии. Если отпустить окно в этот момент, оно станет плавающим и приобретет размер, который имело до закрепления. Плавающее окно может быть перемещено в любую позицию экрана; при этом пользователю разрешено изменять его ширину и высоту (рис. 2.17).
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Рис. 2.17. Плавающее окно командных строк





Закрепляется окно команд путем буксировки к верхней или нижней зоне закрепления окна AutoCAD.

В окне командных строк можно прокручивать текст, выполнять его редактирование и повторно вводить команды. Для этого используются стандартные клавиши: ↑, ↓, ←, →, Insert, Delete, Home, End, Page Up, Page Down, Backspace.

При повторении ранее введенных команд удобно воспользоваться комбинацией клавиш Ctrl+C, чтобы копировать выделенный текст в буфер обмена, и Ctrl+V, чтобы вставить содержимое буфера в текстовое окно или окно команд.

Щелчок правой кнопкой мыши в области окна командных строк или текстового окна AutoCAD вызывает контекстное меню, куда входят шесть последних использованных команд, функции копирования выделенного текста или всего протокола команд, вставки текста, а также вызова диалогового окна настройки Options.


Текстовое окно

Просмотреть большую часть протокола команд – так называемую историю команд (command history) – можно, переключившись в текстовое окно, показанное на рис. 2.18. Оно вызывается нажатием функциональной клавиши F2 или командой TEXTSCR, а также из падающего меню View → Display → Text Window (F2).


Конец ознакомительного фрагмента.

Текст предоставлен ООО «ЛитРес».

Прочитайте эту книгу целиком, купив полную легальную версию на ЛитРес.

Безопасно оплатить книгу можно банковской картой Visa, MasterCard, Maestro, со счета мобильного телефона, с платежного терминала, в салоне МТС или Связной, через PayPal, WebMoney, Яндекс.Деньги, QIWI Кошелек, бонусными картами или другим удобным Вам способом.
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